Summary

This application note describes a key feature of UltraScale+™ FPGAs—MultiBoot. The MultiBoot feature in UltraScale+ FPGAs allows the FPGA application to load two or more FPGA bitstreams under the control of the FPGA application. The FPGA application triggers a MultiBoot operation, causing the FPGA to reconfigure from a different configuration bitstream. After a MultiBoot operation is triggered, the FPGA restarts its configuration process as usual. This document discusses step-by-step instructions to implement the MultiBoot feature using ICAP, different methods of triggering fallback, and details on how to use the boot status (BOOTSTS) register for debugging and verifying MultiBoot or fallback operation. The application note includes a reference design to demonstrate the MultiBoot capabilities of UltraScale+ FPGAs using ICAP in SPI mode.

Download the reference design files for this application note from the Xilinx website. For detailed information about the design files, see Reference Design.

Introduction

The UltraScale+ FPGA’s MultiBoot and fallback features support updating systems in the field. The UltraScale™ architecture supports MultiBoot in SPI x1, x2, and x4, which allows the FPGA to load its bitstream from an attached SPI flash device containing two or more bitstreams. Bitstream images can be upgraded dynamically in the field, which is a huge advantage for designers. The FPGA MultiBoot feature enables switching between images in real time. When an error is detected during the MultiBoot configuration process, the FPGA can trigger a fallback feature that ensures a known good design can be loaded into the device.

This application note discusses the UltraScale+ FPGA MultiBoot and fallback feature with respect to the SPI (x1/x2/x4) configuration interface. For this application, a Micron MT25QU01 serial NOR flash memory device is used in SPI x4 configuration mode on the Xilinx KCU116 development board. For further details on the SPI x4 configuration interface, refer to the UltraScale Architecture Configuration User Guide (UG570) [Ref 1].

Basics of MultiBoot and Fallback

The FPGA application triggers a MultiBoot operation, causing the FPGA to reconfigure from a different bitstream. After a MultiBoot operation is triggered, the FPGA restarts its configuration process as usual and clears its configuration memory except for the dedicated MultiBoot logic,
the warm boot start address (WBSTAR) register, and the BOOTSTS register. The FPGA then reconfigures from the SPI flash device with the new bitstream.

**Conditions that Trigger Fallback**

These errors can trigger fallback during configuration:

- IDCODE error
- Cyclic redundancy check (CRC) error
- Watchdog timer timeout error

Fallback can be enabled with the bitstream option BITSTREAM.CONFIG.CONFIGFALLBACK. The watchdog timer is disabled during fallback reconfiguration. If fallback reconfiguration fails, configuration stops and both INIT_B and DONE are held Low.

**Golden Image**

At FPGA power-up, the golden image is loaded starting from address location 0x0 (Figure 1). At power-up, the golden image gets loaded initially. When a MultiBoot trigger event is recognized, the FPGA loads the MultiBoot image from the upper address space. It is possible to have multiple MultiBoot images, and any design can trigger any other image to be loaded. If an error occurs while the MultiBoot image is being booted that causes configuration to fail, the fallback circuitry triggers the golden image to be loaded from address 0x0.

**MultiBoot Image**

The MultiBoot image is loaded from an upper address space. If this image fails to configure, a fallback is automatically triggered to the golden image stored at address 0x0. The fallback functionality allows for system recovery from any failure to load the MultiBoot image, and loads the golden image.

**MultiBoot Reference Design**

This section describes the expected behavior of the MultiBoot reference design, as well as how to compile and verify the reference design using the KCU116 evaluation board. The reference design uses a golden image initial system setup to showcase the MultiBoot capability.

**Golden Image Initial System Setup**

The golden image is loaded starting from address location 0 at FPGA power-up. Next, the golden image design triggers a MultiBoot image to be loaded. This step is beneficial when initial system checking is required prior to loading a run time image. The system checking or diagnostics can be contained in the golden image, and the run time operation can be contained in the MultiBoot image. The golden image loaded at power-up triggers booting from an upper address space. Multiple MultiBoot images can exist, and any design can trigger any other image...
to be loaded. If an error occurs during loading of the MultiBoot image from the upper address space, the fallback circuitry triggers the golden image to be loaded from address 0x0. Figure 1 shows the flow for the golden image initial setup.

![Memory Map of Flash](image)

**Figure 1:** Golden Image Initial Flow Diagram

### Expected Behavior of Images

At power-on, the golden image is configured and the design runs a walking 1 pattern for the GPIO LEDs [0:7]. The UART can also be connected to check the image loaded.

The golden image waits for the DIP SW13[1] to be toggled 0 > 1 > 0 to issue an IPROG and jump to the MultiBoot image at 0x01000000. The reference design uses ICAP to jump to the MultiBoot image. When an IPROG is issued, a message can be seen on the UART.

After successful configuration of the MultiBoot image, the design runs a blinking pattern of all the GPIO LEDs [0:7]. The UART can also be connected to check the image that is loaded. Setting DIP SW13[1] to 1 when in the MultiBoot image causes the system to read the IDCODE of the FPGA and display it via the UART.

While in the golden image and DIP SW13[4] is toggled 0 > 1 > 0, an IPROG jump is issued to 0x02000000 via the ICAP. Because no valid bitstream (configuration image) is available at this address, the watchdog timer will timeout and trigger a fallback to the golden image.

The configuration time for the SPI x4 interface with 51.0 MHz CCLK setting is less than a second. Watchdog timeout takes approximately 15 seconds at the default CCLK frequency.
Compiling MultiBoot Reference Design

The MultiBoot reference design has been implemented with IP Integrator (IPI). Follow the steps below to compile and generate golden and MultiBoot image files.

1. Open the Vivado® tools by selecting **Start > All Programs > Xilinx Design Tools > Vivado 2017.1 > Vivado**.
   a. Select **Open Project**.
   b. Open the KCU116 MultiBoot reference design (<Directory>\KCU116_MB.xpr), as shown in **Figure 1**.

![Figure 1: MultiBoot Reference Design Project](image)

2. The reference design can be recompiled or exported to SDK.
   - To recompile, right-click **synth_1**, select **Reset Runs**, then select **Generate Bitstream**.
   - To export to SDK, open the implemented design and select **File > Export > Export Hardware**.

![Figure 2: MultiBoot Reference Design Project](image)
d. To launch SDK, select **File > Launch SDK** (Figure 2).

**Figure 3:** Launch SDK
2. SDK software compile: The project automatically builds ELF files in SDK. When done, close SDK and return to the Vivado tools (Figure 4).

3. After SDK has compiled the ELF files, they must be associated with the design using the Associate ELF command. The ELF files in the SDK are located in the directories below and are associated in the Vivado Project:

   `<Directory>\KCU116_MB.sdk\golden\Debug\golden.elf`
   `<Directory>\KCU116_MB.sdk\multiboot\Debug\multiboot.elf`

**Figure 4:** Compile ELF File in SDK
4. Right-click one of the ELF files and select **Associate ELF Files** *(Figure 5).*

*Figure 5: Associate ELF File in the Vivado Tools*
5. Click the button to the right of `Multiboot.elf`, select `Golden.elf`, then click **OK** twice (Figure 6).

6. Run `write_bitstream` in the Vivado tools. This generates the golden image bitstream.

7. Rename the generated bit file so that it does not get overwritten when the next steps are executed.

---

**Figure 6:** Associate Golden ELF File in the Vivado Tools
8. Click the button to the right of Multiboot.elf, select Multiboot.elf, then click OK twice (Figure 7).

9. Run write_bitstream in the Vivado tools. This generates the MultiBoot image bitstream.

10. Generate the MCS file using Create_MCS.tcl.

   The file golden.c in SDK continuously monitors DIPSW13 and controls the issue of IPROG based on the DIPSW13 status. Figure 8 shows the sequence of data programmed into the ICAP when IPROG is issued. The sequence of ICAP commands is from the “Example Bitstream for IPROG through ICAP” table in the UltraScale Architecture Configuration User Guide (UG570) [Ref 1].

   ```c
   static u32 ReadId[HVICAP EXAMPLE BITSTREAM LENGTH] = {
      0xFFFFFFFF, /* Dummy Word */
      0x18999566, /* Sync Word*/
      0x20000000, /* Type 1 NO OP */
      0x30020001, /* Write WRFSTAR cmd */
      0x01000000, /* Warm boot start address (Load the desired address) */
      0x30008001, /* Write CMD */
      0x0000000F, /* Write IPROG */
      0x20000000, /* Type 1 NO OP */
    };
   ```

   Figure 8: ICAP Commands for IPROG
Figure 9 shows the SDK golden.c MultiBoot address.

Toggling DIP SW13[1] 0 > 1 > 0 causes the design to issue an IPROG with the WBSTAR address set to 0x01000000.

Toggling DIP SW13[4] 0 > 1 > 0 causes the design to issue an IPROG with the WBSTAR address set to 0x02000000.

Bitstream Settings for the MultiBoot Reference Design

Table 1 shows the bitstream settings used for the MultiBoot reference design. The settings are common to both golden and MultiBoot image bitstreams. The table captures all the default and available values, and the options used for the reference design.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Default Value</th>
<th>Possible Values</th>
<th>Design Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BITSTREAM.CONFIG.SPI_BUSWIDTH</td>
<td>None</td>
<td>None, 1, 2, 4, 8</td>
<td>4</td>
<td>Sets the SPI bus to quad (x4) mode SPI configuration.</td>
</tr>
<tr>
<td>BITSTREAM.CONFIG.CONFIGFALLBACK</td>
<td>Enable</td>
<td>Enable, Disable</td>
<td>Enable</td>
<td>Enables or disables the loading of a default bitstream when a configuration attempt fails.</td>
</tr>
</tbody>
</table>
Design Verification in Hardware

This section describes how to verify your MultiBoot fallback reference design in hardware.

**Hardware Requirements**

- KCU116 evaluation board.
- USB A to micro B cable to plug into the KCU116 Digilent USB-to-JTAG module or Xilinx platform cable USB II.
- USB A to micro B cable to plug into the KCU116 USB UART interface.

**Software Requirements**

- Vivado Design Suite 2017.1 with SDK.
- TeraTerm or any other terminal software for UART connectivity:
  - Baud rate: 9600.
  - Parity, flow control: None.

### Table 1: Bitstream Settings (Cont’d)

<table>
<thead>
<tr>
<th>Settings</th>
<th>Default Value</th>
<th>Possible Values</th>
<th>Design Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BITSTREAM.CONFIG.SPI_32BIT_ADDR</td>
<td>No</td>
<td>No, Yes</td>
<td>Yes</td>
<td>Enables SPI 32-bit address style, which is required for SPI devices with storage of 256 Mb and larger.</td>
</tr>
<tr>
<td>BITSTREAM.CONFIG.CONFIGRATE</td>
<td>3</td>
<td>2.7, 5.3, 8.0, 10.6, 21.3, 31.9, 36.4, 51.0, 56.7, 63.8, 72.9, 85.0, 102.0, 127.5, 170.0</td>
<td>51.0</td>
<td>CCLK is set to 51.0 MHz.</td>
</tr>
<tr>
<td>BITSTREAM.CONFIG.TIMER_CFG</td>
<td>-</td>
<td>-</td>
<td>0x1FFFFFF</td>
<td>Sets the value of the watchdog timer in configuration mode.</td>
</tr>
<tr>
<td>BITSTREAM.GENERAL.COMPRESS</td>
<td>False</td>
<td>True, False</td>
<td>True</td>
<td>Uses the multiple frame write feature in the bitstream to reduce the size of the bitstream, not just the bitstream (.bit) file. Using compress does not guarantee that the size of the bitstream shrinks.</td>
</tr>
<tr>
<td>BITSTREAM.CONFIG.SPI_FALL_EDGE</td>
<td>No</td>
<td>No, Yes</td>
<td>Yes</td>
<td>Sets the FPGA to use a falling edge clock for SPI data capture. This improves timing margins and might allow faster clock rates for configuration.</td>
</tr>
</tbody>
</table>
Board Setup

The mode pin settings should be set to master SPI. M0 and M1 are hardwired on the KCU116 board. M2 should be set to 0 via the SW21 setting (Figure 10).

![Figure 10: SW21.6 Set to 0](image)

The initial DIP SW13 settings should be set to 0000 (Figure 11).

![Figure 11: DIP SW13[1:4] Set to 0000](image)

Programming the Flash

The reference design has pre-generated MCS files that can be used to program the SPI flash MT25QU01 on the KCU116 board. Table 2 contains a description of these files.

<table>
<thead>
<tr>
<th>Filename</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Golden_n_Multiboot.mcs</td>
<td>Golden and MultiBoot image. Successful configuration of both golden and MultiBoot images can be demonstrated.</td>
</tr>
<tr>
<td>Golden_n_Multiboot_CRC_Err.mcs</td>
<td>MultiBoot image CRC is corrupted. Loading MultiBoot results in a CRC error and fallback is triggered.</td>
</tr>
<tr>
<td>Golden_n_Multiboot_ID_Err.mcs</td>
<td>MultiBoot image FPGA IDCODE is corrupted. Loading MultiBoot results in ID code error and fallback is triggered.</td>
</tr>
</tbody>
</table>
Program_KCU116_SPI.tcl can be used on the Vivado Tcl console to program the SPI flash on the KCU116 board. Edits to the Tcl file might be required depending on the MCS file to be programmed. Alternatively, the Vivado tools hardware manager can be used to program the SPIx4 MT25QU01 flash with any of the MCS files described in Table 2. Refer to Vivado Design Suite User Guide: Programming and Debugging (UG908) [Ref 2] for details on programming the flash.

Verifying MultiBoot Operation

To boot the FPGA with the image (Golden_n_Multiboot.mcs) programmed into the flash device, pulse PROGRAM_B by pulsing SW5 on the KCU116 board. Verify that the FPGA was successfully configured with the golden bitstream from the SPI flash using these methods:

- The DONE pin LED on the board should be illuminated.
- The GPIO LEDs [0:7] should illuminate with a walking 1 pattern indicating the golden bitstream was successfully loaded.
- The UART terminal should show the message in Figure 12.

---

---

Figure 12: Golden Image UART Display

- Refresh the device by right-clicking the FPGA in the Vivado IDE and selecting Hardware Device Properties.
• From the Properties box in the Vivado IDE, expand **BOOT_STATUS** and **CONFIG_STATUS** under REGISTER. The **BOOT_STATUS** register confirms that the normal configuration is successful. The **CONFIG_STATUS** register shows the DONE_PIN is High (Figure 13).

<table>
<thead>
<tr>
<th>REGISTER</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BOOT_STATUS</strong></td>
<td>0000000001</td>
</tr>
<tr>
<td>BIT00_0_STATUS_VALID</td>
<td>1</td>
</tr>
<tr>
<td>BIT01_0_FALLBACK</td>
<td>0</td>
</tr>
<tr>
<td>BIT02_0_INTERNAL_PROG</td>
<td>0</td>
</tr>
<tr>
<td>BIT03_O_WATCHDOG_TIMEOUT_ERROR</td>
<td>0</td>
</tr>
<tr>
<td>BIT04_0_ID_ERROR</td>
<td>0</td>
</tr>
<tr>
<td>BIT05_0_CRC_ERROR</td>
<td>0</td>
</tr>
<tr>
<td>BIT06_0_WRAP_ERROR</td>
<td>0</td>
</tr>
<tr>
<td>BIT07_O_SECURITY_ERROR</td>
<td>0</td>
</tr>
<tr>
<td>BIT08_1_STATUS_VALID</td>
<td>0</td>
</tr>
<tr>
<td>BIT09_1_FALLBACK</td>
<td>0</td>
</tr>
<tr>
<td>BIT10_1_INTERNAL_PROG</td>
<td>0</td>
</tr>
<tr>
<td>BIT11_1_WATCHDOG_TIMEOUT_ERROR</td>
<td>0</td>
</tr>
<tr>
<td>BIT12_1_ID_ERROR</td>
<td>0</td>
</tr>
<tr>
<td>BIT13_1_CRC_ERROR</td>
<td>0</td>
</tr>
<tr>
<td>BIT14_1_WRAP_ERROR</td>
<td>0</td>
</tr>
<tr>
<td>BIT15_1_SECURITY_ERROR</td>
<td>0</td>
</tr>
<tr>
<td>BIT16_RESERVED</td>
<td>0000000000000000</td>
</tr>
</tbody>
</table>

> **CONFIG_STATUS**

After confirming that the golden image is successfully loaded, toggle the DIP SW13[1] 0> 1 > 0. The DONE LED turns off for a moment, and the MultiBoot image is loaded. When **IPROG** is issued, the UART displays the message shown in Figure 14.

![IPROG Issued](X17892-050517)

**Figure 14:** **IPROG Issue UART Display**

Verify that the FPGA was successfully configured with the MultiBoot bitstream from the SPI flash using these methods:

• The DONE pin LED on the board should be illuminated.

• The GPIO LEDs [0:7] should illuminate with all LEDs in a blinking pattern (ON/OFF) indicating that the MultiBoot bitstream was successfully loaded.

• The UART terminal should display the message shown in Figure 15.

![MultiBoot Image UART Display](X17892-050517)

**Figure 15:** **MultiBoot Image UART Display**
- Refresh the device by right-clicking the FPGA in the Vivado IDE and selecting **Hardware Device Properties**.

- From the Properties box in the Vivado IDE, expand **BOOT_STATUS** and **CONFIG_STATUS** under REGISTER. The **BOOT_STATUS** register confirms that the IPROG (INTERNAL_PROG) flag that caused the jump to the MultiBoot bitstream is High. The **CONFIG_STATUS** register shows the DONE_PIN is High (Figure 16).

![REGISTER](image.png)

**Figure 16**: MultiBoot Image **BOOT_STATUS**

After confirming that the MultiBoot image is successfully loaded, setting the DIP SW13[1] to 1 causes the design to read the FPGA IDCODE and display it via the UART, as shown in Figure 17.

```
FPGA IDCODE is : 4A62093
```

**Figure 17**: MultiBoot Image FPGA IDCODE Read UART Display
Fallback Example – CRC Error

To boot the FPGA with the image (Golden_n_Multiboot_CRC_Err.mcs) programmed into the flash device, pulse PROGRAM_B by pulsing SW5 on the KCU116 board. After confirming that the golden image is successfully loaded, toggle the DIP SW13[1] 0 > 1 > 0. The DONE LED turns off for a moment and the FPGA tries to load the MultiBoot image. Because the MultiBoot image is corrupted, the FPGA will fallback and load the golden bitstream.

- Refresh the device by right-clicking the FPGA in the Vivado IDE and selecting **Hardware Device Properties**.
- From the Properties box in the Vivado IDE, expand **BOOT_STATUS** and **CONFIG_STATUS** under REGISTER. The BOOT_STATUS register confirms that the IPROG (INTERNAL_PROG) flag caused the jump and CRC error, and the Fallback flag to go High. The CONFIG_STATUS register shows the DONE_PIN is High (**Figure 18**).

<table>
<thead>
<tr>
<th>REGISTER</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BOOT_STATUS</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>BIT00_0.STATUS_VALID</td>
<td>0000000000000000000000000000000010</td>
</tr>
<tr>
<td></td>
<td>BIT01_0_FALLBACK</td>
<td>01</td>
</tr>
<tr>
<td></td>
<td>BIT02_0.INTERNAL_PROG</td>
<td>00</td>
</tr>
<tr>
<td></td>
<td>BIT03_0.WATCHDOG_TIMEOUT_ERROR</td>
<td>00</td>
</tr>
<tr>
<td></td>
<td>BIT04_0.ID_ERROR</td>
<td>00</td>
</tr>
<tr>
<td></td>
<td>BIT05_0.CRC_ERROR</td>
<td>00</td>
</tr>
<tr>
<td></td>
<td>BIT06_0.WRAP_ERROR</td>
<td>00</td>
</tr>
<tr>
<td></td>
<td>BIT07_0.SECURITY_ERROR</td>
<td>00</td>
</tr>
<tr>
<td></td>
<td>BIT08_1.STATUS_VALID</td>
<td>01</td>
</tr>
<tr>
<td></td>
<td>BIT09_1_FALLBACK</td>
<td>00</td>
</tr>
<tr>
<td></td>
<td>BIT10_1.INTERNAL_PROG</td>
<td>01</td>
</tr>
<tr>
<td></td>
<td>BIT11_1.WATCHDOG_TIMEOUT_ERROR</td>
<td>00</td>
</tr>
<tr>
<td></td>
<td>BIT12_1.ID_ERROR</td>
<td>00</td>
</tr>
<tr>
<td></td>
<td><strong>BIT13_1.CRC_ERROR</strong></td>
<td>01</td>
</tr>
<tr>
<td></td>
<td>BIT14_1.WRAP_ERROR</td>
<td>00</td>
</tr>
<tr>
<td></td>
<td>BIT15_1.SECURITY_ERROR</td>
<td>00</td>
</tr>
<tr>
<td></td>
<td>BIT16_RESERVED</td>
<td>0000000000000000</td>
</tr>
</tbody>
</table>

**Figure 18:** CRC Error BOOT_STATUS
Fallback Example – IDCODE Error

To boot the FPGA with the image (Golden_n_Multiboot_ID_Err.mcs) programmed into the flash device pulse PROGRAM_B by pulsing SW5 on the KCU116 board. After confirming that the golden image is successfully loaded, toggle the DIP SW13[1] 0 > 1 > 0. The DONE LED turns off and the FPGA tries to load the MultiBoot image. Because the MultiBoot image IDCODE is corrupted intentionally, the FPGA will fallback and load the golden bitstream.

- Refresh the device by right-clicking the FPGA in the Vivado IDE and selecting Hardware Device Properties.
- From the Properties box in the Vivado IDE, expand BOOT_STATUS and CONFIG_STATUS under REGISTER. The BOOTSTATUS register confirms that the IPROG (INTERNAL_PROG) flag caused the jump and ID error, and the Fallback flag to go High. The CONFIG_STATUS register shows the DONE_PIN is High (Figure 19).

---

**Figure 19:** IDCODE Error BOOT_STATUS
Fallback Example – Watchdog Timer

To boot the FPGA with the image\(^1\) programmed into the flash device, pulse PROGRAM_B by pulsing SW5 on the KCU116 board.

After confirming that the golden image is successfully loaded, toggle the DIP SW13[4] 0 > 1 > 0. The DONE LED turns off and the FPGA tries to load the MultiBoot image. Because the jump is to address \(0x02000000\) and no valid configuration image is available, the FPGA watchdog timer will timeout (timeout is approximately 15s) and trigger a fallback. The FPGA will fallback and load the golden bitstream.

- Refresh the device by right-clicking the FPGA in the Vivado IDE and selecting **Hardware Device Properties**.
- From the Properties box in the Vivado IDE, expand **BOOT_STATUS** and **CONFIG_STATUS** under REGISTER. The **BOOT_STATUS** register confirms that the IPROG (INTERNAL_PROG) flag caused the jump and watchdog timeout error, and the Fallback flag to go High. The **CONFIG_STATUS** register shows the DONE_PIN is High (Figure 20).

\[\text{Register Table:}
\]

\[\begin{array}{|c|c|}
\hline
\text{BIT01_0_FALLBACK} & 1 \\
\hline
\text{BIT10_1_INTERNAL_PROG} & 1 \\
\text{BIT11_1_WATCHDOG_TIMEOUT_ERROR} & 1 \\
\text{BIT12_1_ID_ERROR} & 0 \\
\text{BIT13_1_CRC_ERROR} & 0 \\
\text{BIT14_1_WRAP_ERROR} & 0 \\
\text{BIT15_1_SECURITY_ERROR} & 0 \\
\text{BIT10_RESERVED} & 0x00000000 \\
\hline
\end{array}\]

**Figure 20:** Watchdog Timeout Error **BOOT_STATUS**

---

1. Any of the provided MCS files can be used for the image.
Debug

This section provides a checklist to debug common issues for MultiBoot with SPI flash.

Design

• All bitstream properties are correctly set for both the golden and MultiBoot images (see Table 2).
• All SPI bitstream properties are correctly set (see Table 2).
• The command to generate the flash programming file has all the correct options and address settings. Refer to Create_MCS.tcl.
• The IPROG jump address specified in Golden.c matches the address specified while re-generating the MCS file.

Hardware

• The mode pin settings are for master SPI configuration.
• DIPSW13 is set to all 0s initially.
• UART baud rate is set to 9600.
• The flash device is completely erased before attempting to program the flash with the design. The erase can be verified using the blank check option.
• Check the BOOT_STATUS and CONFIG_STATUS registers for errors or behavioral issues to assist with the debug of the MultiBoot reference design. Ensure that the refresh device is completed before reading the registers.
• SW16 is mapped to reset of the reference design. Pushing the switch puts the design in reset.
• PROG_B SW5 switch is released.

Conclusion

This application note describes how the MultiBoot feature in UltraScale+ FPGAs can be used either for updating systems in the field or for loading different configuration images in real time. It provides guidance on how to implement this feature with respect to the SPI (x4) configuration interface. A reference design that demonstrates the operation of the MultiBoot feature is provided for the KCU116 board.
Reference Design

Download the reference design files for this application note from the Xilinx website. Table 3 shows the reference design matrix.

Table 3: Reference Design Matrix

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
</tr>
<tr>
<td>Developer name</td>
<td>Guruprasad Kempahonnaiah</td>
</tr>
<tr>
<td>Target devices</td>
<td>UltraScale+ FPGAs</td>
</tr>
<tr>
<td>Source code provided</td>
<td>Yes</td>
</tr>
<tr>
<td>Source code format</td>
<td>Verilog, C</td>
</tr>
<tr>
<td>Design uses code and IP from existing Xilinx application note and</td>
<td>N/A</td>
</tr>
<tr>
<td>reference designs or third party</td>
<td></td>
</tr>
<tr>
<td><strong>Simulation</strong></td>
<td></td>
</tr>
<tr>
<td>Functional simulation performed</td>
<td>N/A</td>
</tr>
<tr>
<td>Timing simulation performed</td>
<td>N/A</td>
</tr>
<tr>
<td>Test bench used for functional and timing simulations</td>
<td>N/A</td>
</tr>
<tr>
<td>Test bench format</td>
<td>N/A</td>
</tr>
<tr>
<td>Simulator software/version used</td>
<td>N/A</td>
</tr>
<tr>
<td>SPICE/IBIS simulations</td>
<td>N/A</td>
</tr>
<tr>
<td><strong>Implementation</strong></td>
<td></td>
</tr>
<tr>
<td>Synthesis software tools/versions used</td>
<td>Vivado Design Suite 2017.1</td>
</tr>
<tr>
<td>Implementation software tools/versions used</td>
<td>Vivado Design Suite 2017.1</td>
</tr>
<tr>
<td></td>
<td>Xilinx SDK 2017.1</td>
</tr>
<tr>
<td>Static timing analysis performed</td>
<td>N/A</td>
</tr>
<tr>
<td><strong>Hardware Verification</strong></td>
<td></td>
</tr>
<tr>
<td>Hardware verified</td>
<td>Yes</td>
</tr>
<tr>
<td>Hardware platform used for verification</td>
<td>KCU116 evaluation board</td>
</tr>
</tbody>
</table>

References

Revision History

The following table shows the revision history for this document.

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>06/23/2017</td>
<td>1.0</td>
<td>Initial Xilinx release.</td>
</tr>
</tbody>
</table>

Please Read: Important Legal Notices

The information disclosed to you hereunder (the “Materials”) is provided solely for the selection and use of Xilinx products. To the maximum extent permitted by applicable law: (1) Materials are made available “AS IS” and with all faults, Xilinx hereby DISCLAIMS ALL WARRANTIES AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether in contract or tort, including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related to, arising under, or in connection with, the Materials (including your use of the Materials), including for any direct, indirect, special, incidental, or consequential loss or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a result of any action brought by a third party) even if such damage or loss was reasonably foreseeable or Xilinx had been advised of the possibility of the same. Xilinx assumes no obligation to correct any errors contained in the Materials or to notify you of updates to the Materials or to product specifications. You may not reproduce, modify, distribute, or publicly display the Materials without prior written consent. Certain products are subject to the terms and conditions of Xilinx’s limited warranty, please refer to Xilinx’s Terms of Sale which can be viewed at http://www.xilinx.com/legal.htm#tos; IP cores may be subject to warranty and support terms contained in a license issued to you by Xilinx. Xilinx products are not designed or intended to be fail-safe or for use in any application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products in such critical applications, please refer to Xilinx’s Terms of Sale which can be viewed at http://www.xilinx.com/legal.htm#tos.

AUTOMOTIVE APPLICATIONS DISCLAIMER

AUTOMOTIVE PRODUCTS (IDENTIFIED AS “XA” IN THE PART NUMBER) ARE NOT WARRANTED FOR USE IN THE DEPLOYMENT OF AIRBAGS OR FOR USE IN APPLICATIONS THAT AFFECT CONTROL OF A VEHICLE (“SAFETY APPLICATION”) UNLESS THERE IS A SAFETY CONCEPT OR REDUNDANCY FEATURE CONSISTENT WITH THE ISO 26262 AUTOMOTIVE SAFETY STANDARD (“SAFETY DESIGN”). CUSTOMER SHALL, PRIOR TO USING OR DISTRIBUTING ANY SYSTEMS THAT INCORPORATE PRODUCTS, THOROUGHLY TEST SUCH SYSTEMS FOR SAFETY PURPOSES. USE OF PRODUCTS IN A SAFETY APPLICATION WITHOUT A SAFETY DESIGN IS FULLY AT THE RISK OF CUSTOMER, SUBJECT ONLY TO APPLICABLE LAWS AND REGULATIONS GOVERNING LIMITATIONS ON PRODUCT LIABILITY.

© Copyright 2017 Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Vivado, Zynq, and other designated brands included herein are trademarks of Xilinx in the United States and other countries. All other trademarks are the property of their respective owners.